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Information for your safety and
comfort

Read these instructions carefully. Keep this document for future reference. Follow
all warnings and instructions marked on the product.

Before cleaning

. Turn the product off and unplug it from the wall outlet before cleaning.
. Do not use liquid cleaners or aerosol cleaners. Use a damp cloth for cleaning.

Location precautions

Be sure that the power outlet you plug the power cord into is easily accessible and
located as close to the equipment operator as possible. When you need to
disconnect power to the equipment, be sure to unplug the power cord from the
electrical outlet.

. Do not use this product near water.

. Do not place this product on an unstable cart, stand or table. If the product
falls, it could be seriously damaged.

. Slots and openings are provided for ventilation to ensure reliable operation of
the product and to protect it from overheating. These openings must not be
blocked or covered. The openings should never be blocked by placing the
product on a bed, sofa, rug or other similar surface.

. This product should never be placed near or over a radiator or heat register, or
in a built-in installation unless proper ventilation is provided.

. Never push objects of any kind into this product through cabinet slots as they
may touch dangerous voltage points or short-out parts that could result in a
fire or electric shock. Never spill liquid of any kind onto or into the product.

. To avoid damage of internal components and to prevent battery leakage, do
not place the product on a vibrating surface.

. Never use it under sporting, exercising, or any vibrating environment which will
probably cause unexpected short circuits and may damage rotor devices or
the lamp.

Using electrical power

. This product should be operated from the type of power indicated on the
marking label. If you are not sure of the type of power available, consult your
dealer or local power company.

. Do not allow anything to rest on the power cord. Do not locate this product
where people will walk on the cord.

. If an extension cord is used with this product, make sure that the total ampere
rating of the equipment plugged into the extension cord does not exceed the
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extension cord ampere rating. Also, make sure that the total rating of all
products plugged into the wall outlet does not exceed the fuse rating.

. Do not overload a power outlet, strip or receptacle by plugging in too many
devices. The overall system load must not exceed 80% of the branch circuit
rating. If power strips are used, the load should not exceed 80% of the power
strip's input rating.

. This product's AC adapter is equipped with a three-wire grounded plug. The
plug only fits in a grounded power outlet. Make sure the power outlet is
properly grounded before inserting the AC adapter plug. Do not insert the plug
into a non-grounded power outlet. Contact your electrician for details.

Warning! The grounding pin is a safety feature. Using a power
outlet that is not properly grounded may result in electric shock
and/or injury.

Note: The grounding pin also provides good protection from
unexpected noise produced by other nearby electrical devices that
may interfere with the performance of this product.

. Use the product only with the supplied power supply cord set. If you need to
replace the power cord set, make sure that the new power cord meets the
following requirements: detachable type, UL listed/CSA certified, VDE
approved or its equivalent, 4.6 meters (15 feet) maximum length.
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Product servicing

Do not attempt to service this product yourself, as opening or removing covers may
expose you to dangerous voltage points or other risks. Refer all servicing to
qualified service personnel.

Unplug this product from the wall outlet and refer servicing to qualified service
personnel when:

. The power cord or plug is damaged, cut or frayed.

. Liquid was spilled into the product.

. The product was exposed to rain or water.

. The product has been dropped or the case has been damaged.

. The product exhibits a distinct change in performance, indicating a need for
service.

. The product does not operate normally after following the operating
instructions.

Note: Adjust only those controls that are covered by the operating
instructions, since improper adjustment of other controls may result
in damage and will often require extensive work by a qualified
technician to restore the product to normal condition.

Warning! For safety reasons, do not use non-compliant parts
when adding or changing components. Consult your reseller for
purchase options.

Warning! This device and its enhancements may contain small
parts. Keep them out of the reach of small children.

Additional safety information

. Do not look into the projector's lens when the lamp is on. The light may hurt
your eyes.

. Turn on the projector first and then signal sources

. Do not place the product in following environments:

. Locations that are confined or poorly ventilated. The projector must have
at least 50 cm clearance from walls and have free flowing air around it.

. Locations where temperatures may become excessively high, such as
inside of a car with all windows rolled up.

. Locations where excessive humidity, dust, or cigarette smoke may
contaminate optical components.
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. Locations near fire alarms.

. Locations with an ambient temperature above 40° C/104° F.
. Locations where the altitudes are higher than 10,000 feet.

. Do not operate if smoke, a strange noise, or an odor are coming out of the
projector. In this case, immediately unplug the projector and contact your
dealer.

. Do not keep using the projector if it has been dropped or damaged. In this
case, contact your dealer for inspection.

. Do not face the projector lens to the sun. It can lead to fire.

. Do not frequently turn off the main power abruptly or unplug the projector
during operation. It is best to wait for the fan to turn off before turning off the
projector's power.

. Do not touch the air outlet grille or bottom plate because they may be hot.

. If the projector has an air filter, clean it regularly. If left uncleaned, the
temperature inside might rise and cause damage.

. Do not look into the air outlet grille when projector is operating. It may hurt
your eyes.

. Do not block the projector lens with any object when the projector is under
operation as this could cause the object to become heated and deformed or
even cause a fire.

. The lamp becomes extremely hot during operation. Allow the projector to cool
for approximately 45 minutes prior to removing the lamp assembly for
replacement.

. Do not operate lamps beyond the rated lamp life.

. Never replace the lamp assembly or any electronic components unless the
projector is unplugged.

. The product will detect the life of the lamp itself. Change the lamp when the
warning message is displayed.

. Reset the Lamp Hour Reset function from the onscreen display Management
menu after replacing the lamp module.

. Do not attempt to disassemble the projector, as opening or removing covers
may expose you to dangerous voltage points or other risks. Refer all servicing
to qualified service personnel.

. Do not stand the projector on its end vertically. The projector may fall over,
causing injury or damage.

. This product is capable of displaying inverted images for ceiling-mounted
installation. Only use an Acer ceiling mount kit and ensure it is securely
installed.

Protect your hearing

To protect your hearing, follow these instructions.
. Increase the volume gradually until you can hear clearly and comfortably.
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. Do not increase the volume level after your ears have adjusted.
. Do not listen to music at high volumes for extended periods.
. Do not increase the volume to block out noisy surroundings.

. Decrease the volume if you can't hear people speaking near you.

Disposal instructions

Do not throw this electronic device into the trash when discarding. To minimize
pollution and ensure utmost protection of the global environment, please recycle.
For more information on the Waste from Electrical and Electronics Equipment
(WEEE) regulations, visit
www.acer-group.com/public/Sustainability/sustainability01.htm

Mercury advisory

For projectors or electronic products containing an LCD/CRT monitor or display:
E “Lamp(s) contain Mercury,
Dispose Properly.”

Lamp(s) inside this product contain mercury and must be recycled or disposed of
according to local, state or federal laws. For more information, contact the
Electronic Industries Alliance at www.eiae.org. For lamp-specific disposal
information, check www.lamprecycle.org
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Introduction

Product features

This product is a single-chip DLP projector, feautring:

DLP technology.

Native 1024 x 768 XGA resolution.

Acer ColorSafe Il technology ensures consistent color rendition over time.
Smart detection delivers quick, intelligent source detection.

Versatile display modes (Bright, Presentation, Standard, Video, Education,
Picture, Game, User) for optimum performance in any situation.

NTSC / PAL / SECAM compatible and HDTV (720p, 1080i, 1080p) supported.

Lower power consumption and economy (ECO/Dynamic Black) mode extends
lamp life.

Acer EcoProjeciton Technology delivers Intelligent power management
approach and physical efficiency improvement.

Empowering Key reveals Acer Empowering Technology utilities (Acer eView,
eTimer, ePower Management, e3D Management) for easy adjustment of
settings.

P1223/D413D/EV-X34H: Equipped with HDMI connection supporting HDCP.
Advanced digital keystone correction optimizes presentations.
Multi-language onscreen display.

0.8 to 1.85X digital zoom and pan move function.

Microsoft Windows 2000, XP, Vista, Windows 7, and Macintosh OS compliant
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Package contents

This projector comes with all the items shown below. Check to make sure your unit
is complete. Contact your dealer immediately if anything is missing.

W P
i 1)

Power cord VGA cable

(2 )

Batteries User’s Manual CD

Quick Start Guide Carrying case (optional)  Screw pack

Dust filter
(optional)
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Projector overview

Front / top

1 |Lamp cover 6 |Zoom lens
2 |Zoomring 7 |Control panel
3 |Focus ring 8 |Ventilation (inlet)
4 |Ventilation 9 |[Speaker
5 |Remote control receivers
Rear
ii & (
i l© . ¢ T [©)
\ ‘ o L]
i W ]
1110 9 8 7
1 |Audio input connector 7 |Kensington lock port
2 |HDMI input connector 8 |Monitor loop-through output
connector (VGA-OUT)
3 |S-Video input connector 9 |Composite video input connector

4 |PC analog signal/HDTV/component {10 |Power socket
video input connector (VGA 1-IN or
VGA 2-IN)

5 |RS-232 connector 11 |Audio output connector
6 |Mini USB connector
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Control panel

1 2 3
r N \
Aw
< o wa|l power
MENU
SOURCE “W, |1-Resync || LAmMP/TEMP
A=K
———————————— | - v/a 6

1 SOURCE Changes the active source.
2| o KEYSTONE Adjusts the image to compensate for distortion
o caused by tilting the projector (+ 40 degrees).
3 RESYNC Automatically synchronizes the projector to the
input source.
4 POWER Power indicator LED
5 LAMP/ Lamp/Temp Indicator LED
TEMP
6 MENU . Press MENU to launch the onscreen display
(OSD) menu, back to the previous step for the
OSD menu operation or exit the OSD menu.
. Confirm your selection of items.
71 ", | Four Use up, down, left, right buttons to select items or
v directional make adjustments to your selection.
select keys
8 0) POWER Refer to "Turning the projector on/off" on page 9.
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Remote control layout

1 1
e N e
2 2
3 12 3 N (O3 12
. i ot O Gy
14 zooM MUTE 14
; s s—1 O s
(-7 | R 16
17 17
18 18
[J— [
17 _ _ 17
7------ *
8 — i =~ 19
9 20
10
* *
11 *
P1223/D413D/EV-X34H X1223/D413/EV-X34

1 Remote Sends signals to the projector.
control
transmitter
2 FREEZE Pauses the screen image.
3 o POWER Refer to "Turning the projector on/off" on page 9.
4 ASPECT To choose the desired aspect ratio.
RATIO
5 ZOOM Zooms the projector display in or out.
6 . ", | Four Use up, down, left, right buttons to select items
v directional or make adjustments to your selection.
select keys
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7 KeyPad 0to 9 | Press 0to 9 to enter a password when required.

8 VIDEO Press VIDEO to change source to composite
video.

9 VGA Press VGA to change source to the VGA1-IN/
VGA2-IN connector. This connector supports
analog RGB, YPbPr (480p/576p/720p/1080i),
YCbCr (480i/576i) and RGBsync.

10 COMPONENT | Press COMPONENT to change source to the
VGA1-IN/VGA2-IN connector. This connector
supports analog RGB, YPbPr (480p/576p/720p/
1080i), YCbCr (480i/576i) and RGBsync.

11 HDMI/DVI Press HDMI/DVI to change source to HDMI/
DVI.

12 HIDE Momentarily turns off the video. Press HIDE to
hide the image, press again to display the
image.

13 SOURCE Changes the active source.

14 RESYNC Automatically synchronizes the projector to the
input source.

15 Empowering Launches Acer functions: eView, eTimer,

Key ePower, e3D Management.
16 | Laser button Aim the remote at the viewing screen, press and
hold this button to activate the laser pointer.
MUTE Turns the sound on/off.
17 | & KEYSTONE Adjusts the image to compensate for distortion
o caused by tilting the projector (= 40 degrees).
18 MENU . Press MENU to launch the onscreen
display (OSD) menu, back to the previous
step for the OSD menu operation or exit
the OSD menu.
. Confirm your selection of items.
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19 Page For computer mode only. Use this button to

select the next or previous page. This function is

only available when connected to a computer
via a USB cable.

20 S-VIDEO Press S-VIDEO to change source to S-Video.

This function is only available when a USB cable
is not connected to a computer.

Note: Buttons marked with * are not operational on this projector.

CAUTION

BONOT STARE T BEAM MadelNo:RC-281RR-190

Reting: D63V === 1mAMAX ﬁ\/

CE FE :g VZ.JCQ00.001

P1223/D413D/EV-X34H X1223/D413/EV-X34
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Getting started

Connecting the projector

n!:

!

CJ
m-e D

= —

S-Video output

1*  Audio cable 5* | USB cable

2*  HDMI cable 6* | S-Video cable

3 VGA cable 7* | Composite video cable
4*  RS-232 cable 8 Power cord
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Note: To ensure the projector works well with your computer, please
make sure the timing of the display mode is compatible with the
projector.

Note: * indicates an optional item.

Turning the projector on/off

Turning the projector on

1 Ensure that the power cord and signal cable are securely connected. The
power indicator LED will light blue.

2  Turn on the projector by pressing the POWER button on the control panel. The
power indicator LED will flash and then turn blue.

3  Turn on your source (computer, notebook, video player ,etc.). The projector
will detect your source automatically.

. If the screen displays the Lock and Source icons, it means the projector is
locked onto a specific source type and that input signal type is not
detected.

. If the screen displays No Signal, please make sure the signal cables are
securely connected.

. If you connect to multiple sources at the same time, use the SOURCE
button on the remote control to switch between inputs.
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Turning the projector off

1 To turn the projector off, press the power button. This message appears:
Please press the power button again to complete the shutdown process. Press
the power button again.

2  The shutdown process will vary depending on the Turn Off Mode setting.
Please refer to "Management" on page 28 for more details.

3  Once the shutdown process finishes, the power indicator LED becomes
steady blue.

4  Itis now safe to unplug the power cord.

Warning messages!

. Projector Overheated. Lamp will automatically turn off soon.
This onscreen message indicates that the projector has overheated. The
lamp with automatically turn off, the projector will automatically shut
down, and the LED temp indicator will blink. Contact your local dealer or
service center.

. Fan Fail. Lamp will automatically turn off soon.
This onscreen message indicates that the fan has failed. The lamp will
automatically turn off, the projector will automatically shut down, and the
LED temp indicator will turn solid blue. Contact your local dealer or
service center.

Note: Whenever the projector automatically shuts down and the LED
power, temp and lamp indicators blink, contact your local reseller or
service center.

Adjusting the projected image

Adjusting the height of the projected image

The projector is equipped with an elevator foot for adjusting the image height.
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To raise/lower the image:

1 Use the elevator foot raise/lower the image to the desired height.

Nl 1 1 | - LT LT LT LT LT LT O T 1] "
1T | | N = | s 1§ T 1T THT 11T 1T 1= T T T
A 11 R I Y
TT T Al f&l [T Bl THC TT

1T 1 T T T =1 THT T H T T BT TR

T 1T T AL T T 11T 1T T 1T g
TT ] N Y O N — - 1 | N O | — I \
1T 1 T T T 1= THT H__HI T T 1

1T 1 T T T T 1T 1T AT 1T 11T T T
1 == 1= 0 = =1 R =1 R~
1 D == O 1 D = = = |

A\

Elevator foot
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Optimizing image size and distance

Consult the table below to find the optimal image sizes achievable when the
projector is positioned at a desired distance from the screen. Example: If the

projector is 3 m from the screen, good image quality is possible for image sizes
between 68" and 75".

Note: The image will be 148 cm high when the projector is 3 m from

the screen.

Min
Sery
en S 75" ‘*
IZa

B |

\

\

" A
681 X \\
\ \
\ \
\ |
\ 1
\ |
— i Height: 148 cm
. From base to
I top of image

Height: "

135¢m|

,l C Il

A _--27 Lol

e - v /
% ol a<==-"""  Desired distance >
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Desired Screen size Top Screen size Top
distance
(m) (Min zoom) (Max zoom)
<A> Diagonal [ W (cm) x From base to |Diagonal| W (cm)x | From base to top
(inches) H (cm) top of image | (inches) H (cm) of image (cm)
<B> (cm) <C> <B> <C>
1.5 34 69 x 52 68 37 76 x 57 74
2 46 93 x 69 90 50 102 x 76 99
2.5 57 116 x 87 113 62 127 x 95 124
3 68 139 x 104 135 75 152 x 114 148
3.5 80 162 x 122 158 87 178 x 133 173
4 91 185 x 139 181 100 203 x 152 198
4.5 103 208 x 156 203 112 228 x 171 223
5 114 231 x 174 226 125 254 x 190 247
6 137 278 x 208 271 150 305 x 228 297
7 159 324 x 243 316 175 355 x 266 346
8 182 370 x278 361 200 406 x 305 396
9 205 417 x 313 406 225 457 x 343 445
10 228 463 x 347 451 250 508 x 381 495
11 251 509 x 382 497 275 558 x 419 544
12 273 556 x 417 542 300 609 x 457 594
Zoom Ratio: 1.1x
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Adjusting distance and zoom to optimize image size

|
P 'D
/ Height
From base to
g top of image
B 1
!
1
1
!
- !
,”/,// 1
--7 Lz /
0 -~ Tom 7T ¥
%IHIH AT T T
- 22m
Desired distance
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The table below shows how to achieve a desired image size by adjusting either the
position or the zoom ring. Example: To obtain an image size of 50" set the projector
at a distance between 2 m and 2.2 m from the screen and adjust the zoom level

accordingly.
Desired image size Distance (m) Top (cm)
Diagonal (inches) | W (cm) x H (cm) Max zoom Min zoom From base to top of

<A> <B> <C> image <D>
30 61 x 46 1.2 1.3 59

40 81 x 61 1.6 1.8 79

50 102 x 76 2.0 2.2 99

60 122 x 91 2.4 2.6 119

70 142 x 107 2.8 3.1 139

80 163 x 122 3.2 3.5 158

90 183 x 137 3.6 4.0 178
100 203 x 152 4.0 4.4 198
120 244 x 183 4.8 5.3 238
150 305 x 229 6.0 6.6 297
180 366 x 274 7.2 7.9 357
200 406 x 305 8.0 8.8 396
250 508 x 381 10.0 11.0 495
300 610 x 457 12.0 594

Zoom Ratio: 1.1x
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User controls

Installation menu

16

The installation menu provides an onscreen display (OSD) for projector installation
and maintenance. Use this OSD only when the message No signal input is

displayed on the screen.

The menu options include settings and adjustments for screen size and distance,

focus, keystone correction and more.

1 Turn on the projector by pressing the POWER button on the control pad.

2 Press the MENU button on the control pad to launch the OSD for projector
installation and maintenance.

4} Enter Aw Select MENU  Exit

acer

Installation

L N FEaan

Menu Location B Y =l a

Keystone (i ]

Language 4 English »

Reset »

4p Enter Aaw Select MENU  Exit

3 The background pattern acts as a guide for adjusting the calibration and
alignment settings, such as screen size and distance, focus and more.

4  The Installation menu includes the following options:

. Projection method
. Menu location

. Keystone settings
. Language settings

. Reset to factory defaults

Use the up and down arrow keys to select an option, the left and right arrow
keys to adjust selected option settings, and the right arrow key to enter a
feature settings submenu. The new settings will be saved automatically upon

exiting the menu.

5 Push the MENU button anytime to exit the menu and return to the Acer

welcome screen.

Downloaded From projector-manual.com Acer Manuals

Downloaded from www.Manualslib.com manuals search engine



http://www.manualslib.com/

17

Acer Empowering Technology

Acer eView Management

€ mpowering Menu

ﬂo‘!*

Acer eView Managerment

Presentation Game
Standard Education

Video User

€ Adjust £ Select MENU Exit

The Acer Empowering @ Key provides
access to four Acer-specific functions: Acer
eView Management, Acer eTimer
Management, Acer ePower Management,
and Acer e3D Management. Press the @
key for more than one second to launch the
onscreen display main menu to modify its
function.

Press @ to launch the Acer eView
Management submenu.

Acer eView Management is for display mode
selection. Please refer to "Onscreen Display
Menus" on page 19 for more details.

Acer eTimer Management

€ mpowering Menu

m [ ¢

Acer eTimer Management

Period 120 Minutes
Display Countdown

Location Bl nlee)]

@ Adjust > Select MENU Exit

Press @ to launch Acer eTimer
Management submenu.

Acer eTimer Management offers a reminder
function for presentation time control. Please
refer to "Onscreen Display Menus" on page
19 for more details.

Acer ePower Management

€ mpowering Menu

Eo‘ﬂa}

Acer ePower Management

High Altitude

Auto Shutdown

@ Adjust » Select MENU Exit

Press @ to launch Acer ePower
Management.

Acer ePower Management offers a shortcut
to save lamp and projector life. Please refer
to "Onscreen Display Menus" on page 19
for more details.

Downloaded From projector-manual.com Acer Manuals

Downloaded from www.Manualslib.com manuals search engine



http://www.manualslib.com/

Acer e3D Management

€ mpowering Menu

Ijo?a

Acer e3D Management

- s

3D Sync Invert

Invert b

3D Warning Message 4 »

€ Adjust <» Select MENU  Exit

18

Press @ to launch Acer e3D Management.
Acer e3D Management offers quick access
to 3D functions. Please refer to "Onscreen
Display Menus" on page 19 for more details.
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Onscreen Display Menus

The projector has a multilingual OSD that allows you to make image adjustments
and change a variety of settings.

Using the OSD menus

To open the OSD menu, press MENU on the remote control.

When the OSD is displayed, use the @@ keys to select any item in the

main menu. After selecting the desired main menu item, press @ to enter the
feature settings submenu.

Use the @@ keys to select the desired item and adjust the settings by

using the @@ keys.

Select the next item to be adjusted in the submenu and adjust as described
above.

Press MENU on the remote control to return to the main menu.

To exit the OSD, press MENU on the remote control again. The OSD menu will
close and the projector will automatically save the new settings.

@ Color
- 4 Standard P

Wwall Color o T T |

Brightness

Main menu

Setting

Contrast
Saturation

Tint

Dynamic Black

Advanced

-
4p Adjust 4w Select MENU | Exit

Submenu
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Color
‘9 Color
de 4 Standard »

Wall Color -0 B R |
Brightness
Contrast
Saturation
Tint
Dynamic Black
Advanced

4p Adjust -~ Se;ct MENU  Exit

Display Mode There are many factory presets optimized for various types of

image.

. Bright: For high brightness environments.

. Presentation: Higher brightness for meetings and
presentations.

. Standard: For normal environments.

. Video: For playing video in a bright environment.

. Education: For education environment.

. Picture: For pictures.

. Game: For game content.

. User: User-adjustable to suit your environment.

Wall Color Use this function to choose a proper color according to the wall.
There are several choices, including white, light yellow, light blue,
pink, dark green. The projector will compensate for color deviation
due to the wall color to show the correct image tone.

Brightness Adjust the brightness of the image.

. Press @ to darken image.
. Press @ to lighten the image.

Contrast Contrast controls the difference between the lightest and darkest
parts of the picture. Adjusting the contrast changes the amount of
black and white in the image.

. Press @ to decrease the contrast.
. Press @ to increase the contrast.

Saturation Adjusts a video image from black and white to fully saturated color.
. Press @ to decrease the amount of color in the image.

. Press @ to increase the amount of color in the image.
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Tint Adjusts the color balance of red and green.
. Press @ to increase the amount of green in the image.
. Press @ to increase the amount of red in the image.
Dynamic Black Choose On to dim the projector lamp which will automatically

detect the brightness level of the content and reduce lamp power

consumption (up to 70 percent). Choose Off to turn off Dynamic
Black.

Advanced Use this function to adjust advanced color settings.

Advanced

. . Color Temperature: Adjust the color temperature. At higher
[BEr Tamporature color temperatures, the screen looks colder; at lower color
: temperatures, the screen looks warmer.
. Degamma: Effects the representation of dark scenery. With
greater gamma value, dark scenery will look brighter.

. Color R: Adjusts the red color.

-
av Select meny Exit

. Color G: Adjusts the green color.
. Color B: Adjusts the blue color.
. Color C: Adjusts the cyan color.
. Color Y: Adjusts the yellow color.

. Color M: Adjusts the magenta color.

Note: Saturation and Tint are not supported under computer mode.
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d Image [id Image

Aspect Ratio Aspect Ratio

Keystone Keystone

Sharpness Sharpness

H. Position H. Position

V. Position V. Position

Frequency Frequency

Tracking Tracking

HDMI Color Range Auto

HDMI Scan Info Auto

4> Adjust Av Select MENU | Exit 4 Adjust Av Select MENU | Exit

P1223/D413D/EV-X34H X1223/D413/EV-X34
Projection
E] . Front: The factory default setting.
=| . Ceiling: When you select this function, the projector inverts the
image for ceiling-mounted projection.
:I . Rear: When you select this function, the projector reverses the
image so you can project from behind a translucent screen.
. Rear-Ceiling: When you select this function, the projector
I |= reverses and inverts the image at same time. You can project
from behind a translucent screen with ceiling mounted
projection.
Aspect Ratio Use this function to choose your desired aspect ratio.
43 16:9 . Auto: Keep the image with original width-higth ratio and

E b E maximize the image to fit native horizontal or vertical pixels.
. Full: Keep the image with its original resolution, and resized to
fit within the display area.
. 4:3: The image will be scaled to fit the screen and displayed
using a 4:3 ratio.
. 16:9: The image will be scaled to fit the width of the screen and
the height adjusted to display the image using a 16:9 ratio.

Keystone Adjust image distortion caused by tilting the projector (x40 degrees).
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Sharpeness Adjusts the sharpness of the image.
. Press @ to decrease the sharpness.
. Press @ to increase the sharpness.
H. Position R :
(horizontal Press @ to move the image left.
position) . Press @ to to move the image right.

V. Position (vertical
position)

J Press @ to move the image down.
. Press @ to move the image up.

Frequency

Frequency changes the projector's refresh rate to match the
frequency of your computer’s graphics card. If you can see a vertical
flickering bar in the projected image, use this function to make the
necessary adjustments.

Tracking

Synchronizes the signal timing of the projector with the graphics
card. If you experience an unstable or flickering image, use this
function to correct it.

HDMI Color
Range

Adjust the color range of the HDMI image data to correct color
display errors.

d Auto: Automatically adjust using information from the player.

. Limited Range: Process the input image as limited color range
data.
. Full Range: Process the input image as full color range data.

HDMI Scan Info

Adjust the overscan ratio of the HDMI image on screen.
d Auto: Automatically adjust using information from the player.
. Underscan: Disable overscan on HDMI images.

. Overscan: Enable overscan on HDMI images.

Note: H. Position, V. Position and Frequency functions are not
supported under Component video, Video, S-Video and HDMI
modes.

Note: Tracking function is not supported under HDMI, Video and S-
Video modes.

Note: The unsupported functions will be grayed out.
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Setting

I}$ Setting

Startup Screen 4 Acer

Screen Capture

Reset

»
>
Closed Caption >
>
»

Security
w
4 Adjust A¥ Select MENU | Exit

Menu Location Choose the menu location on the display screen.

Startup Screen Use this function to select your desired startup screen. If you change
the setting, the changes will take effect when you exit the OSD
menu.

. Acer: The default Acer projector startup screen.

. User: Use a customized picture from the screen capture
function.
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Screen Capture Use this function to customize the startup screen. To capture the
image that you want to use as the startup screen, follow the
instructions below.

Note: Before proceeding with the following steps,
make sure that the Keystone is set to the default
value 0 and the aspect ratio is set to 4:3. For details,
refer to "Image" on page 22.

. Change the Startup Screen from the default setting (Acer) to

User.
_ . Press Screen Capture to customize the startup screen.
Screen capture in progress
Rlosss yalt . A message appears, stating that the screen capture is in
progress.

. When the screen capture is finished, the message disappears
and the original display is shown.

. The customized startup screen will take effect when there is a
new input signal or when you restart the projector.

Note: This screen capture function is limited to the
4:3 aspect ratio only.

Note: For XGA models, to get best quality for your
desired image, set the PC resolution to 1024 x 768
before you use this function.

Note: For SVGA models, to get best quality for your
desired image, set the PC resolution to 800 x 600
before you use this function.

Note: For WXGA models, to get best quality for your
desired image, set the PC resolution to 1280 x 800
before you use this function.

Closed Caption Selects a preferred closed captioning mode from CC1, CC2, CC3,
CC4, (CC1 displays captions in the primary language in your area).
Select Off to turn off the captioning feature. This function is only
available when a composite video or S-Video input signal is selected
and its system format is NTSC.

Note: Set your screen aspect ratio to 4:3. This
function is not available when the aspect ratio is
16:9, Auto, Full or L.Box.

Reset Press the @ button and choose YES to return the parameters on

all menus to the factory default settings.
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Security Security

Enter Administrator Password This projector is equipped with a useful security function for the
administrator to manage projector use.
Press @ to change the Security setting. If the security function is

enabled, your must enter the Administrator Password first before
changing the security settings.

Enter Password

. Select On to enable the security function. The user has to
enter a password to operate the projector. Please refer to the
User Password section for details.

. If Off is selected, then the user can turn on the projector
without password.

Once the security function is enabled, the projector will request user

to enter password when switch on the projector. Both User

Password and Administrator Password can be used.

Timeout(Min.)

Once Security is activated, the administrator can set the timeout
function.

. Press @ or @ to select the timeout interval.

. The range is from 10 minutes to 990 minutes.

. When the time is up, the projector will prompt the user to enter
the password again.

. The factory default setting of Timeout(Min.) is Off.

User Password

Set User Password

. Press @ to set up or change the User Password.

New Password

Confirm Password . Use the number keys to set your password on the remote
control and press MENU to confirm.

b 0~8:input

. Press @ to delete a character.

. Enter the password again when you see Confirm Password
displayed.

. The password should be between four and eight characters
long.

. If you select Request password only after plugging power

cord, the projector will prompt the user to enter the password
every time the power cord is plugged in.

. If you select Always request password while projector turns
on, the user has to enter the password every time the projector
is turned on.
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Administrator Password

SetAdmiatrtor Eassword The Administrator Password can be used in both the Enter
NewPassword Administrator Password and Enter Password dialog boxes.

Confirm Password

. Press @ to change the Administrator Password.

. The default Administrator Password is 1234.
Y If you forgot your administrator password, do the following to
retrieve the administrator password:

. Press MENU for more than four seconds when the Enter
Password or Enter Administrator Password dialog box is
Enter Administrator Password Currently dISplayed

. Write down the Unlock ID and contact with Acer service
center. They will give you a new Administrator Password
according to the Unlock ID.

Lock User Startup Screen

. By default Lock User Startup Screen is Off. If Lock User
Startup Screen is On, users cannot change the startup screen
anymore.

. Choose Off to unlock startup screen.
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Management

(G2 Management

-

High Altitude

Turn Off Mode Instant Resume
Auto Shutdown

Lamp Hour Elapse

Lamp Reminding

Lamp Hour Reset
-
4P Adjust 4A¥ Select MENU Exit

Choose On to dim the projector lamp which will lower power

ECO Mode . . )
consumption, extend the lamp life and reduce noise. Choose Off to
return normal mode.

High Altitutde Choose On to turn on High Altitude mode. Operate the fans at full
speed continuously to allow for proper cooling of the projector.
Turn Off Mode . Instant Off: Enables you to turn off the projector immediately,
without fan cooling process, by pressing the power button
twice.
. Instant Resume: Enables you to restart the projector

immediately, without a two minute cool-down period.

Auto Shutdown The projector will automatically shutdown when there is no signal
input after the allocated time (in minutes).

Lamp Hour Elapse Displays the lamp’s elapsed operating time (in hours).

Lamp Reminding Activate this function to display a reminder to change the lamp 30
hours before its expected end-of-life.

Lamp Hour Reset Press the @ button and choose Yes to reset the lamp hour

counter to 0 hours.

Audio

%) Audio
Woiime

Mute

4r Adjust Av¥ Select MENU | Exit

Volume . Press @ to decrease the volume.

. Press @ to increase the volume.
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Mute . Choose On to mute the volume.
. Choose Off to restore the volume.

3D

sp 3D
[ . >

3D Sync Invert Invert b

3D Warning Message On »

4 Adjust Av Select MENU Exit

3D Choose On to enable the 3D functions supported by Tl DLP 3D
technology. Choose this item when using DLP 3D glasses, a quad
buffer (NVIDIA or ATI) graphics card and HQFS format file or DVD
with corresponding SW player. Choose Off to turn off 3D mode.

3D Sync Invert If you see an blurred or overlapping image while wearing DLP 3D
glasses, you may need to turn On 3D Sync Invert to get the best
match for left/right image sequencing to get a clear image. This
function is only available while 3D is set to On.

3D Warning Message Choose On to display 3D warning message.
. Choose Off to turn off 3D warning message.

Note: The correct settings on the graphics card 3D application
program are needed for correct 3D display.

Note: Some software players, such as Stereoscopic Player and DDD
TriDef Media Player can support 3D format files. You can download

these three players from the pages below:
- NVIDIA Stereoscopic 3D Video Player:
www.nvidia.com/object/3D_Drivers_Downloads.html
- Stereoscopic Player (Trial): www.3dtv.at/Downloads/Index_en.aspx
- DDD TriDef Media Player (Trial):
www.tridef.com/download/latest.html
Note: There is a reminder screen if 3D is still enabled when the
projector is turned on. Please adjust the setting depending on your
purpose.

Note: 3D display is now enabled.
1 Please make sure you have the correct 3D signals and glasses

2. Please remember to turn off 3D if you don't want to see 3D images.

3. If the 3D display isn't correct, please try to enable 3D Sync Invert.

4. Display mode options will be disabled while in 3D mode.
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Language

82 Language

ry

Deutsch

Frangais
Italiano
Espafiol
Portugués
B&=
P
PR
P¥CcCcERA
Polski
Tlna
MNederlands
Geétina
Dansk
Svenska
Hagvyar
Torkse
T
Viét Nam
duyy=ll
hd
» Enter aw Select MENU  Exit

Language Choose the language for your OSD menu. Use the @ or @
key to select your preferred language.

Press @ to confirm the selection.
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3D projection

The Acer projector you have bought has integrated DLP 3D technology.

Important: When you turn the 3D technology on, you will be shown a
reminder that 3D is enabled. If you do not wish to view 3D content,
you should turn it off, otherwise the image may not be projected at
full brightness.

Note: 3D display is now enabled.

1. Please make sure you have the correc t 3D signals and gl

2. Please remember to turn off 3D if you don't want to see 3D images.

3. If the 3D display isn't correct, please try to enable 3D Sync Invert.

4. Display mode options will be disabled while in 3D mode.

Using DLP 3D technology

Before you can enjoy the benefits of the DLP 3D technology, you will need to do the
following.

1 Ensure your graphics card supports 3D playback.

Note: Please refer to your graphics card’s documentation.

2 Download and install the latest drivers for your graphics card.

Note: Please refer to your graphics card vendor’s website for the
latest driver version.

3  You should also download a suitable 3D player such as the one available from
www.3dtv.at.

Note: You may need to purchase additional software.

4  Ensure you have the correct DLP-compatible 3D glasses.

Setting up a 3D environment

Once you have installed the drivers, you will need to set up the environment.

1 Set the refresh rate to 120 Hz on your graphics card.
2 Press the menu button on the projector remote control to open the OSD.
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3 Set 3D to On.

sb 3D

. >

3D Sync Invert Invert p

3D Warning Message 3

4r Adjust 4w Select MENU | Exit

4  Alternatively, press @ on your projector’s remote control to open Acer e3D
Management. From the 3D options, select On.

€ mpowering Menu

GO'QG

Acer e3D Management

N >

3D Sync Invert Invert p

3D Warning Message 3

€ Adjust ) Select MENU | Exit

5 If you find that the 3D content is not displaying properly, try selecting 3D Sync
Invert from the projector OSD or Acer e3D Management.

€ mpowering Menu
B o

3p 3D
> Acer e3D Management

[ »

3D Sync Invert Invert b ‘ >

3D Warning Message » 3D Sync Invert Invert »

40 Adjust AWY Sglect MENU Exit 3D Warning Message 3

@ Adjust > Select MENU | Exit
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Important: If you have an NVIDIA graphics card and the NVIDIA 3D
Vision drivers installed, you may need to disable the Stereoscopic
feature to use the DLP 3D technology.
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Using the stereoscopic player

You need to have a stereoscopic player in order to view 3D content. The
instructions below explain how to view 3D content using the stereoscopic player
that is available at www.3dtv.at. Other players may have different procedures.

1 Open the stereoscopic player and set the viewing method by going to View >
Viewing Method > Software pageflipping.
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2 Open the 3D content in the player.

Note: You need to view content at fullscreen resolution in order to get
the 3D effects.
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Using 3D glasses (optional)

DLP 3D glasses are powered. In order to enhance battery life, they turn off after a
few minutes of inactivity. Before you can view 3D content, you need to ensure the
glasses are turned on. In many cases, there is a power switch on one of the arms
that you can press, and an LED that indicates if the glasses are turned on or not.

Note: Refer to the documentation that came with your glasses for
instructions how to turn them on and how to change the battery.

Watching 3D DVD content

If you have a DVD player that supports 3D playback, you can watch 3D DVD
contant using your Acer 3D-enabled projector. Connect your DVD player to the
projector using any of the available input formats.

1 Press the MENU button on the projector remote control to open the OSD.
2 Set3DtoOn.

sp 3D

. >

3D Sync Invert Invert p

3D Warning Message >

4r Adjust A¥ Select MENU  Exit

3  Alternatively, press @ on your projector’s remote control to open Acer e3D
Management. From the 3D options, select On.

€ mpowering Menu

GO'QG

Acer e3D Management

N >

3D Sync Invert Invert p

3D Warning Message 3

€ Adjust ) Select MENU | Exit
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4 If you find that the 3D content is not displaying properly, try selecting 3D Sync
Invert from the projector OSD or Acer e3D Management.

€ mpowering Menu

E'lo,’El

Acer e3D Management

p 3D
. >

3D Sync Invert Invert b _: »

3D Warning Message » 3D Sync Invert Invert P

4» Adjust 4¥ Select MENU Exit 3D Warning Message »

@ Adjust <) Select MENU | Exit
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Appendices

Troubleshooting

If you experience a problem with your Acer projector, refer to the following
troubleshooting guide. If the problem persists, please contact your local reseller or

service center.

Image problems and solutions

# Problem

Solution

displayed image
[For PC (Windows

1 No image appears . Ensure the projector is properly connected as
onscreen described in "Getting started" on page 8.
. Ensure none of the connector pins is bent or broken.
. Check if the projector lamp has been securely installed.
Please refer to "Replacing the lamp" on page 41.
2 Partial, scrolling or . Press RESYNC on the remote control.
incorrectly e For an incorrectly displayed image:

. Open My Computer > Control Panel, and then
double-click the Display icon.

computer is not
displaying your
presentation

95/98/2000/XP)]
o Select the Settings tab.
. Verify that your display resolution setting is lower
than or equal to UXGA (1600 x 1200).
If the problem still appears, change the monitor display you
are using and follow the steps below:
. Verify that the resolution setting is lower than or
equal to UXGA (1600 x 1200).
. Click the Change button under the Monitor tab.
. Click Show all devices. Next, select Standard
monitor types under the SP box, and choose
the resolution mode you need under the Models
box.
o Verify that the resolution setting of the monitor
display is lower than or equal to UXGA (1600 x
1200).
4 The screen of the . If you are using a Microsoft Windows based notebook:
notebook Some notebook PCs may deactivate their own screens

when a second display device is in use. Each has a
different way to be reactivated. Refer to your
computer's manual for detailed information.

o If you are using an Apple Mac OS based notebook: In
System Preferences, open Display and select Video
Mirroring On.
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Image is unstable
or flickering

Adjust the Tracking to correct it. Refer to "Image" on
page 22 for more information.

Change the display color depth settings on your
computer.

Image has vertical
flickering bar

Use Frequency to make an adjustment. Refer to
"Image" on page 22 for more information.

Check and reconfigure the display mode of your
graphics card to make it compatible with the projector.

Image is out of
focus

Adjusts the focus ring on the projector lens.

Make sure the projection screen is within the required
distance from the projector. Refer to "Optimizing
image size and distance" on page 12 for more
information.

Image is stretched
when displaying a
widescreen DVD
title

When you play a DVD encoded in anamorphic or 16:9 aspect
ratio you may need to adjust the following settings:

If you play a 4:3 format DVD title, please change the
format to 4:3 in the projector OSD.

If the image is still stretched, you will also need to
adjust the aspect ratio. Set up the display format to
16:9 (wide) aspect ratio on your DVD player.

Image is too small
or too large

Adjust the zoom ring on the front of the projector.
Move the projector closer to or further from the screen.

Press MENU on the remote control. Go to Image >
Aspect Ratio and try different settings or press Aspect
Ratio on the remote control to adjust directly.

Image has slanted
sides

If possible, reposition the projector so that it is
centered on the screen.

Press the Keystone [\ / U button on the remote
control until the sides are vertical.

10

Image is reversed

Select Image > Projection on the OSD and adjust the
projection direction.

Problems with the projector

Condition

Solution

The projector stops responding

to all controls

If possible, turn off the projector, then unplug
the power cord and wait at least 30 seconds
before reconnecting power.
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2 Lamp burns out or makes a .
popping sound

When the lamp reaches the end of its
useful life, it will burn out and may make
a loud popping sound. If this happens,
the projector will not turn on until the
lamp module has been replaced. To
replace the lamp, please refer to
"Replacing the lamp" on page 41.

OSD messages

# Condition Message

1 Message Fan Fail - the system fan is not working.

Projector Overheated - the projector has exceeded its
recommended operating temperature and must be allowed to
cool down before it may be used.

Projector Overheated.

Lamp will automatically turn off soon

Replace the lamp - the lamp is about to reach its maximum
lifetime. Prepare to replace it soon.
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LED and alarm definitions
LED indicators

Indicator Power LED Temp LED Lamp LED
Blue Blue Red
Power events
Standby \" -- --
Normal turn on mode Flashing for 30 -- --
seconds after
power on then
steady blue
Download mode \'% Flashing Flashing
Normal turn off mode \Y Solid on for 1 Solid on for 1
second second
Turn on mode with Flashing for 15 After 15 seconds After 15 seconds
cooling seconds then then solid on for 45 then solid on for 45
steady blue seconds seconds
Lamp events
Lamp ignition fail \" -- Flashing
End of lamp lifetime \ -- \Y,
Thermal events
Temperature error \" Flashing --
Fan error \" \" --
Color wheel or DMD \Y Flashing Flashing
error
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Replacing and cleaning the dust filter

Turn the projector off then unplug the power cord.
Pull the dust filter out (lllustration #1).

Clean or replace the dust filter.

To put the dust filter back, reverse the previous steps.

-
-—W -

(Nustration #1)
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Cleaning the dust filter

Clean the dust filter after every 1000 hours of use. If it is not cleaned periodically, it
can become clogged with dust, preventing proper ventilation. This can cause
overheating and damage the projector. (Normally 1000 hours is recommended,
however the period will vary depending on actual environment.)

Please follow these steps for cleaning procdure:

1 To clean the dust filter, use a small vacuum cleaner designed for computers
and other office equipment. It also can be cleaned using water. (lllustration #2)

2  If the dirt is difficult to remove or the filter is broken, please contact your local
dealer or service center to obtain a new filter.

Dust Filter
(NMustration #2)
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Replacing the lamp

The projector will detect the lamp life. You will be shown a warning message: Lamp
is approaching the end of its useful life in full power operation. Replacement
Suggested! When you see this message, change the lamp as soon as possible.
Make sure the projector has cooled down for at least 45 minutes before changing
the lamp.

Warning! Do not attempt to replace the lamp yourself. Contact
the qualified service personnel for replacement.

Warning! The lamp compartment is hot! Allow it to cool down
before changing the lamp.

To change the lamp:

1 Turn off the projector by pressing the Power button.

2  Allow the projector at least 45 mins to cool down.

3  Disconnect the power cord.

4  Use a screwdriver to remove the screws on the two sides of the cover
(NMustration #1).

Push up and remove the cover.

Remove the two screws that secure the lamp module (lllustration #2) and pull
up the lamp bar (lllustration #3).

7 Pull out the lamp module (lllustration #4).

o O,

To replace the lamp module, reverse the previous steps.

Warning! To reduce the risk of personal injury, do not drop the
lamp module or touch the lamp bulb. The bulb may shatter and
cause injury if it is dropped.
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Ceiling mount installation

If you wish to install the projector using a ceiling mount, please refer to the steps
below:

1 Drill four holes into a solid, structurally sound part of the ceiling, and secure
the mount base.

0
]

(RS
in
wuw o€l

S N
&

e ----
e

Note: Screws are not included. Please obtain the appropriate screws
for your type of ceiling.

2  Secure the ceiling rod using the appropriate type of four-cylinder screws.

= = =N TS T ) Ceiling Mount Base
- Attach to ceiling
=J = o~ = o=J = o=

Short Rod = -1 I
y ™ o ™ o ™ o
(] 0 0

s i Tie The
(] 0 0

- Long Rod

0 0
0 0
0 0
0 ]

o ¢ deg

kgl o - Extension Rod
u@ﬁ — Long Cylinder Cap
-0 e Allen Key
Screw Type A Sl Crer . ‘
50 mm length / 8 mm diameter - o For tightening/loosening
o Tightening Screw

Medium Rod
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3  Use the appropriate number of screws for the projector size to attach the
projector to the ceiling mount bracket.

Screw Type B
Smaller Washer

Large Washer

Projector Bracket
Supports projector and allows -

for adjustments

Note: It is recommended that you keep a reasonable space between
the bracket and the projector to allow for proper heat distribution.
Use two washers for extra support, if deemed necessary.

4  Attach the ceiling bracket to the ceiling rod.

Large cylinder cap

Allen Key
Screw Type A - For tightening/loosening
50 mm length - Tightening Screw

/8 mm diameter
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5  Adjust the angle and positioning as necessary.

Tightening Screw

Allen Key

Allen Key

Tightening Screw

Note: The appropriate type of screw and washer for each model is
listed in the table below. 3 mm diameter screws are enclosed in the

screw pack.
Models Screw Type B Washer Type
Diameter (mm) Length (mm) Large Small
P1223/D413D/ |4 8 \Y Vv
EV-X34H/X1223/
D413/EV-X34

SCREW SPEC. M4 x 8 mm

193.6 mm

139.0 mm

o 000000
o 00Qo0o0Q
0o0go0o00Q
cooo0o0co0Q
000000000
cocoocooocaaq

leceoooocoocod
©

210.6 mm
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The specifications listed below are subject to change without notice. For final
specs, please refer to Acer's published marketing specifications.

Projection system

DLP®

Resolution

Native: XGA (1024 x 768), Maximum: UXGA (1,600 x
1,200), 1080p (1920 x 1080)

Computer compatibility

IBM PC and compatibles, Apple Macintosh, iMac and
VESA standards: SXGA, XGA, VGA, SVGA, SXGA+,
WXGA, WXGA+, WSXGA +

Video compatibility

NTSC, PAL, SECAM
Component 720p 1080i 1080p

Aspect ratio

Native 4:3

Displayable colors

16.7 million colors

Projection lens

F/1.97 - 2.17, 1.1X manual zoom lens

Projection screen size (diagonal) 27" - 250"
Projection distance 12m-10m
Throw ratio 1.97 -2.17
Horizontal scan rate 30k - 100 kHz
Vertical refresh scan rate 50 - 120 Hz

Lamp type

240 W user-replaceable lamp

Keystone correction

+ 40 degrees

Audio

Internal speaker with 2 W output

Weight

2.3 kg (5.0 Ibs))

Dimensions (W x D x H)

289.3 x234.5x92.3 mm (11.4" x9.2" x 3.6")

Digital zoom

2X

Power supply

AC input 100 - 240 V auto-switching power supply

Power consumption

320 W (max.)

Operating temperature

5°Cto35°C/41°Fto95°F

I/0O connectors

Power socket

VGA input x2

Mini-B USB

RS-232

Composite video

S-Video

VGA output

3.5 mm audio jack input

3.5 mm audio jack output
HDMI (P1223/D413D/EV-X34H)
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Standard package contents o Power cord
o VGA cable
. Remote control
. Batteries (for remote control)
o User's Manual CD
. Quick Start Guide
. Carrying case (optional)
. Screw pack
. Dust filter (optional)

* Design and specifications are subject to change without notice.
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Compatibility modes

A. VGA analog
1 VGA analog - PC signal

Modes Resolution V. Frequency [Hz] | H. Frequency [kHZz]
VGA 640 x 480 60 31.47
640 x 480 72 37.86
640 x 480 75 37.50
640 x 480 85 43.27
640 x 480 119.51 61.60
SVGA 800 x 600 56 35.20
800 x 600 60 37.88
800 x 600 72 48.08
800 x 600 75 46.88
800 x 600 85 53.67
800 x 600 119.85 77.20
XGA 1024 x 768 60 48.36
1024 x 768 70 56.48
1024 x 768 75 60.02
1024 x 768 85 68.67
1024 x 768 119.804 98.80
SXGA 1152 x 864 70 63.80
1152 x 864 75 67.50
1152 x 864 85 77.10
1280 x 1024 60 63.98
1280 x 1024 72 77.90
1280 x 1024 75 79.98
1280 x 1024 85 91.15
QuadVGA 1280 x 960 60 60.00
1280 x 960 75 75.00
SXGA+ 1400 x 1050 60 65.32
1400 x 1050 75 82.00
UXGA 1600 x 1200 60 75.00
PowerBook G4 640 x 480 60 31.50
640 x 480 66.6 (67) 35.00
800 x 600 60 37.88
1024 x 768 60 48.36
1152 x 870 75 68.68
1280 x 960 75 75.20
i Mac DV (G3) 1024 x 768 75 60.30
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Modes Resolution V. Frequency [Hz] | H. Frequency [kHZz]
WXGA 1280 x 768 60 47.78
1280 x 768 75 60.29
1280 x 768 85 68.63
1280 x 720 60 44.80
1280 x 720 75 56.00
1280 x 720 85 64.00
1280 x 800 60 49.60
1280 x 800 75 62.00
1440 x 900 60 55.90
1680 x 1050 60 65.30
1366 x 768 60 47.71
1920 x 1080-RB 60 66.60
1024 x 600 60 37.30

3  VGA analog - Component signal

Modes Resolution V. Frequency [Hz] | H. Frequency [kHZz]
480i 720 x 480 59.94 (29.97) 27.00
480p 720 x 480 59.94 31.47
576i 720 x 576 50 (25) 27.00
576p 720 x 576 50 31.25
720p 1280 x 720 60 45.00
720p 1280 x 720 50 37.50
1080i 1920 x 1080 60 (30) 33.75
1080i 1920 x 1080 50 (25) 33.75

1080p 1920 x 1080 60 67.50
1080p 1920 x 1080 50 56.26
Horizontal scan rate: 30k-100 kHz
Vertical scan rate: 50-120 Hz

B. HDMI digital
1 HDMI - PC signal
Modes Resolution V. Frequency [Hz] | H. Frequency [kHZz]

VGA 640 x 480 60 31.47

640 x 480 72 37.86

640 x 480 75 37.50

640 x 480 85 43.27

640 x 480 119.51 61.60

SVGA 800 x 600 56 35.20

800 x 600 60 37.88
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800 x 600 72 48.08

800 x 600 75 46.88

800 x 600 85 53.67

800 x 600 119.85 77.20

XGA 1024 x 768 60 48.36
1024 x 768 70 56.48

1024 x 768 75 60.02

1024 x 768 85 68.67

1024 x 768 119.804 98.80

SXGA 1152 x 864 70 63.80
1152 x 864 75 67.50

1152 x 864 85 77.10

1280 x 1024 60 63.98

1280 x 1024 72 77.90

1280 x 1024 75 79.98

1280 x 1024 85 91.15

QuadVGA 1280 x 960 60 60.00
1280 x 960 75 75.00

1280 x 960 85 86.00

SXGA+ 1400 x 1050 50 54.00
1400 x 1050 60 65.32

1400 x 1050 75 82.00

UXGA 1600 x 1200 60 75.00

2  HDMI - Extended wide timing

Modes Resolution V. Frequency [Hz] | H. Frequency [kHZz]
WXGA 1280 x 768 60 47.78
1280 x 768 75 60.29
1280 x 768 85 68.63
1280 x 720 60 44.80
1280 x 720 75 56.00
1280 x 720 85 64.00
1280 x 800 60 49.60
1280 x 800 75 62.00
1440 x 900 60 55.90
1680 x 1050 60 65.30
1366 x 768 60 47.71
1920 x 1080-RB 60 66.60
1024 x 600 60 37.30
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Modes Resolution V. Frequency [Hz] | H. Frequency [kHZz]
480i 720 x 480 59.94 (29.97) 27.00
480p 720 x 480 59.94 31.47
576i 720 x 576 50 (25) 27.00
576p 720 x 576 50 31.25
720p 1280 x 720 60 45.00
720p 1280 x 720 50 37.50
1080i 1920 x 1080 60 (30) 33.75
1080i 1920 x 1080 50 (25) 33.75

1080p 1920 x 1080 60 67.50
1080p 1920 x 1080 50 56.26
Horizontal scan rate: 30k-100 kHz
Vertical scan rate: 50-120 Hz
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Regulations and safety notices
FCC notice

This device has been tested and found to comply with the limits for a Class B digital
device pursuant to Part 15 of the FCC rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
device generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to
radio communications.

However, there is no guarantee that interference will not occur in a particular
installation. If this device does cause harmful interference to radio or television
reception, which can be determined by turning the device off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

. Reorient or relocate the receiving antenna.
. Increase the separation between the device and receiver.

. Connect the device into an outlet on a circuit different from that to which the
receiver is connected.

. Consult the dealer or an experienced radio/television technician for help.

Notice: Shielded cables

All connections to other computing devices must be made using shielded cables to
maintain compliance with FCC regulations.

Notice: Peripheral devices

Only peripherals (input/output devices, terminals, printers, etc.) certified to comply
with the Class B limits may be attached to this equipment. Operation with non-
certified peripherals is likely to result in interference to radio and TV reception.

Caution

Changes or modifications not expressly approved by the manufacturer could void
the user's authority, which is granted by the Federal Communications Commission,
to operate this device.

Operation conditions

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

Notice: Canadian users
This Class B digital apparatus complies with Canadian ICES-003.
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Remarque a l'intention des utilisateurs canadiens

Cet appareil numérique de la classe B est conforme a la norme NMB-003 du
Canada.

Declaration of Conformity for EU countries

Acer hereby declares that this projector series is in compliance with the essential
requirements and other relevant provisions of Directive 1999/5/EC.

Compliant with Russian regulatory certification

C G

ME61
Radio device regulatory notice

Note: The regulatory information below is for models with wireless
LAN and/or Bluetooth only.

General

This product complies with the radio frequency and safety standards of any country
or region in which it has been approved for wireless use. Depending on
configurations, this product may or may not contain wireless radio devices (such as
wireless LAN and/or Bluetooth modules).

Canada — Low-power license-exempt radio
communication devices (RSS-210)

a  Common information
Operation is subject to the following two conditions:
1. This device may not cause interference, and
2. This device must accept any interference, including interference that
may cause undesired operation of the device.

b  Operation in 2.4 GHz band
To prevent radio interference to the licensed service, this device is
intended to be operated indoors and installation outdoors is subject to
licensing.

List of applicable countries

This device must be used in strict accordance with the regulations and constraints in the
country of use. For further information, please contact the local office in the country of use.
Please see http://ec.europa.eu/enterprise/rtte/implem.htm for the latest country list.
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Acer Incorporated
8F, 88, Sec. |. Xintai Gth Rd. Xizhi,
New Taipei ity 221, Taiwan

C€

Declaration of Conformity

We,
Acer Incorporated
8F, 88, Sec. 1, Xintai 5th Rd., Xizhi, New Taipei City 221, Taiwan
Contact Person: Mr. RU Jan, e-mail:ru_jan@acer.com.tw
And,
Acer Italy s.r.1
Via Lepetit, 40, 20020 Lainate (MI) Italy
Tel: +39-02-939-921, Fax: +39-02 9399-2913, www.acer.it

Hereby declare that:

Product: DLP Projector

Trade Name: Acer

Model Number: FNX1107/ FNX1108

Machine Type:  P1223/D413D/EV-X34H/X1223/D413/EV-X34

Is compliant with the essential requirements and other relevant provisions of the following EC
directives, and that all the necessary steps have been taken and are in force to assure that
production units of the same product will continue comply with the requirements.

EMC Directive 2004/108/EC as attested by conformity with the following
harmonized standards:

-. EN55022, AS/NZS CISPR22, Class B

-. EN55024

-. EN61000-3-2 Class A

-.EN61000-3-3

Low Voltage Directive 2006/95/EC as attested by conformity with the following
harmonized standard:
-. EN60950-1

RoHS Directive 2002/95/EC on the Restriction of the Use of certain Hazardous
Substances in Electrical and Electronic Equipment

-. The maximum concentration values of the restricted substances by weight in homogenous
material are:

Lead 0.1% |Polybrominated Biphenyls (PBB’s) 0.1%
Mercury 0.1% | Polybrominated Diphenyl Ethers (PBDE’s) [0.1%
Hexavalent Chromium  [0.1% |Cadmium 0.01%

Directive 2009/125/EC with regard to establishing a framework for the setting
of ecodesign requirements for energy-related product.
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Acer Incorporated
8F, 88, Sec. |, Xintai Gth Rd., Xizhi,
New Taipei City 221, Taiwan

The standards listed below are applied to the product if built with WLAN
module or wireless keyboard and mouse.

CEO

R&TTE Directive 1999/5/EC as attested by conformity with the following
harmonized standard:

® Article 3.1(a) Health and Safety
-. EN60950-1
-. EN62311

® Article 3.1(b) EMC
-. EN301 489-1
-. EN301 489-17

® Article 3.2 Spectrum Usages
-. EN300 328
-. EN301 893 (Applicable to SGHz high performance RLAN).

Year to begin affixing CE marking 2012.

AaT
il U’lA_lw‘* Feb. 10,2012 -

RU Jan/Sr. Manager Date
Regulation Center, Acer Inc.
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Acer America Corporation

333 West San Carlos St., San Jose
CA 95110, U.S. A.

Tel : 254-298-4000

Fax : 254-298-4147
www.acer.com

C

Federal Communications Commission
Declaration of Conformity

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference
that may cause undesired operation.

The following local Manufacturer / Importer is responsible for this declaration:

Product:
Model Number:
Machine Type:

Name of Responsible Party:

Contact Person:
Phone No.:

Fax No.:

Address of Responsible Party:

DLP Projector

FNX1107/FNX1108
P1223/D413D/EV-X34H/X1223/D413/EV-X34
Acer America Corporation

333 West San Carlos St.
San Jose, CA 95110
U.S. A.

Acer Representative
254-298-4000

254-298-4147

Downloaded From projector-manual.com Acer Manuals

Downloaded from www.Manualslib.com manuals search engine


http://www.manualslib.com/

